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Restyle

Restyle verwenden

Allgemeine Einfiihrung: Restyle

Restyle ist eine Reverse Engineering-Umgebung und ermdglicht es Ihnen, ein
Flachen-CAD-Modell auf facettierten (triangulierten) Daten neu aufzubauen. Sie
kdénnen die facettierten Daten direkt importieren, oder sie durch Konvertierung einer
Punktewolke mithilfe der Facetten-Modellierungsfunktion von Pro/ENGINEER
erzeugen.

Restyle bietet einen umfassenden Satz von automatischen, halbautomatischen und
manuellen Werkzeugen an, mit denen Sie die folgenden Aufgaben ausfihren kénnen:

Kurven, sowie Kurven auf facettierten Daten erzeugen und andern.

Erzeugen Sie Isolinien- und Extremum-Kurven mit der Oberflachenanalyse an
facettierten Daten. Die Isolinien-Kurven stellen ausgewahlte Punkte auf
facettierten Daten dar, die in etwa dem Wert der Isolinien-Analyse entsprechen.
Die Extremum-Kurven stellen die ausgewahlten Punkte auf facettierten Daten
dar, die in etwa den Extremwerten der Extremum-Analyse entsprechen.

Mithilfe der facettierten Daten analytische Flachen, Flachen durch Extrusion und
Rotation erzeugen und editieren.

Freiform-Polynomfldchen, sowie B-Spline- und Bezier-Flachen mit hohem Grad
unter Verwendung der facettierten Daten und Kurven erstellen, editieren und
manipulieren.

Freiform-Flachen an facettierte Daten anpassen.

Konnektivitatsbedingungen, einschlieBlich Positions-, Tangential- und
Krimmungsbedingungen zwischen Flachen und Kurven erzeugen und verwalten.

Verbindungs- und Tangential-Bedingungen zwischen Fldchen verwalten.

Einfache Flachen-Modellierungsoperationen ausfiihren, wie Extrapolation und das
Verschmelzen von Flachen.

Automatisch Spline-Flachen auf facettierten Daten erzeugen.

Hinweis:

Fir die Verwendung von Restyle benétigen Sie die Lizenzen fiir Pro/SURFACE und
Reverse_Engineering.

Die in Restyle erzeugten Bezugspunkte, Bezugsfldchen und Bezugsebenen sind
ein Teil des Restyle-KEs. Sie kénnen nicht gedndert werden.

Sie kénnen das in Restyle erstellte Flachen-CAD-Modell in allen nachgeschalteten
Operationen und Anwendungen von Pro/ENGINEER verwenden.
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Allgemeine Einfiihrung: Die Restyle-Umgebung

Restyle ist eine Direktmodellierungs-Umgebung, die es Ihnen ermdglicht, sich auf
einen bestimmten Bereich des Facetten-Modells zu konzentrieren und eine Vielzahl
von Werkzeugen zu verwenden, um die gewlnschte Form und die gewilinschten
Flacheneigenschaften zu erzielen.

Um Ihre Konstruktion in einem einzelnen KE zu isolieren, verwendet Restyle das
"Restyle-KE"-Konzept. Das Restyle-KE ist ein libergreifendes KE, das alle Geometrien
und Referenzdaten umfasst, die in Restyle erzeugt wurden.

Alle im Restyle-KE erzeugten Geometrien werden Bestandteil des Restyle-KE. Das
Restyle-KE hdngt vom zugrundeliegenden Facetten-KE ab. Es hangt ebenfalls von
den Flachen- bzw. Kurven-KEs ab, die zum Erzeugen oder Definieren von Flachen
und Kurven verwendet werden. Wenn Sie eines dieser KEs andern, wird auch das
Restyle-KE aktualisiert.

Hinweis: Ein vom Restyle-KE referenziertes Facetten-KE kann geléscht werden,
indem das Restyle-KE ausgesetzt wird. In diesem Fall bleibt die Restyle-Geometrie
unverandert. Nachdem Sie das Facetten-KE geldscht haben, kann Restyle kein
weiteres Facetten-KE referenzieren.

In Restyle kénnen Sie asynchrone Bezugselemente wie Ebenen, Punkte und
Koordinatensysteme erstellen. Die in Restyle erzeugten Bezugselemente werden ein
Teil des Restyle-KE. Die resultierenden Elemente verlieren somit bei der Erstellung
alle Referenzen und ihre Definition kann nicht editiert werden.

Es sind keine Eltern-Kind-Beziehungen zwischen Kurven und Fléachen vorhanden, die
im Restyle-KE erstellt wurden. Stattdessen werden die geometrischen Beziehungen
zwischen Fldchen und zwischen Flachen und Kurven beibehalten. Das Andern einer
Kurve z.B., die zur Erzeugung einer Flache verwendet wurde, flihrt zur Aktualisierung
dieser Flache.

Nach dem Restyle-KE erzeugte KEs kdnnen in Restyle erzeugte geometrische
Elemente als Referenzen verwenden, wie alle anderen geometrischen Objekte.

Hinweis:
e Sie kdénnen in Restyle mit allen Bezugselementen arbeiten.

e Eine einmal durchgefiihrte Fldchenliberschneidung kann nicht mehr geandert
werden.

e Wenn Sie in Restyle eine Polynomflache mit Hilfe von Kurven erstellen, die eine
geschlossene Schleife bilden, werden alle Facetten-Eckpunkte innerhalb der
Schleife automatisch dieser Flache zugewiesen.

e Das Léschen von facettierten Daten fihrt auch zu einer Reduzierung der
DateigroBe.

¢ Die mit einem Restyle-KE erzeugten Spritzguss- und Fertigungsmodelle werden
entsprechend des Restyle-KE assoziiert.
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So erzeugen Sie ein Restyle-KE

Wahlen Sie die Befehlsfolge Einfiigen > Restyle (Insert > Restyle).
Pro/ENGINEER erzeugt das Restyle-KE und zeigt die Restyle-Tool-Leiste an.

Die facettierten Daten in Restyle verwenden

1.

Wahlen Sie die Befehlsfolge Datei > Neu (File > New), um ein Pro/ENGINEER
Teil zu starten.

Hinweis: Wenn Sie bereits mit facettierten Daten arbeiten, fiihren Sie nur den
letzten Schritt aus.

Wahlen Sie die Befehlsfolge Einfiigen > Gemeinsam benutzte Daten > Aus
Datei (Insert > Shared Data > From File). Das Dialogfenster Offnen (Open)
wird angezeigt.

Wahlen Sie die zu 6ffnende Datei mit den facettierten Daten und klicken Sie auf
Offnen (Open). Das Dialogfenster Importoptionen (Import Options) wird
angezeigt.

Wahlen Sie das Koordinatensystem, das als Referenz flir das Einfligen der
Geometrie verwendet werden soll.

Wahlen Sie die erforderlichen Einheiten im Feld Einheiten (Units) aus.
Klicken Sie auf OK.

Wahlen Sie die Befehlsfolge Einfiigen > Restyle (Insert > Restyle).
Pro/ENGINEER erzeugt das Restyle-KE und zeigt die Restyle-Tool-Leiste an.
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Restyle-Arbeitsablauf

Der allgemeine Arbeitsablauf fir die Erzeugung eines Modells in Restyle sieht
folgendermaBen aus:

Offnen Sie das erforderliche Facetten-KE in Pro/ENGINEER, oder fligen Sie es ein.

Verwenden Sie die Befehlsfolge Einfligen > Restyle (Insert > Restyle), um die
Restyle-Umgebung aufzurufen.

Analysieren Sie mit unterschiedlichen Flachenanalysen wie maximale Krimmung,
GauBsche Krimmung, dritte Ableitung, Steigung usw. Verwenden Sie die
schattierte Ansicht, um die Struktur des erforderlichen Flachenmodells zu erfassen.

Diese Analysen kénnen Ihnen behilflich sein, beim Identifizieren von:
o Analytischen Flachen, wie Ebenen, Kegeln und Zylindern.
o Verfahrenstechnischen Flachen, wie extrudierte und gedrehte Flachen.

o Bedeutenden nicht-analytischen Flachen, oder komplexen exakten Flachen
mit eindeutig definierten Berandungen, wie z.B. aerodynamische Flachen,
die Sie erzeugen missen.

o Organischen Formen, wo die Berandungen einzelner Flachen nicht wichtig
sind.

o Teilen des erforderlichen Flachenmodells, die Sie mit den Pro/ENGINEER
Standard-KEs, z.B. Rundungen, erzeugen kénnen.

Starten Sie, indem Sie die einfacheren und gréBeren Flachen konstruieren, die Sie
als Richtungsreferenzen flir komplexere verfahrenstechnische Flachen und fir
Flachenanalysen verwenden kdnnen.

Erzeugen Sie Flachen mit den verschiedenen Werkzeugen zur Flachenerzeugung,
wie Erzeugen von Kurven auf Facetten, aus Analysen, durch Uberschneidung mit
einer Ebene oder 3D-Kurven.

Sie kédnnen auch eine Domane auf der Facetten-Darstellung erzeugen. Verwenden
Sie diese Domane zum Erzeugen einer analytischen Flache, die nur von der Domédne
beeinflusst wird.

Hinweis: Es ist nicht notwendig, eine Domane zu erzeugen. Sie kénnen
analytische Flachen durch die Auswahl von einem oder zwei Punkten erzeugen.
Alle analytischen Werkzeuge zur Flachenerzeugung arbeiten mit oder ohne die
Erzeugung von Domadnen. Ohne eine Domane kann es jedoch mdglich sein, dass
die resultierende analytische Fléache nicht der facettierten Geometrie folgt. Mit
Doménen lassen sich analytische Teilansichten erzeugen, z.B. ein Teil eines
Zylinders, Kegels oder einer Rotationsachse. Sie kénnen Domédnen auch
verwenden, wenn eine extrudierte Flache nur in einem lokalen Bereich des
Modells erzeugt werden muss, auch wenn die Schnittebene das komplette
Facetten-Modell schneidet.
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e Sie konnen flr Freiform-Flachen auch die Werkzeuge Einpassen (Fit) und
Projekt (Project) verwenden. Einer Flache muss eine Domane oder
Referenzpunkte zugewiesen sein, um sie einzupassen.

¢ Wenn die Flachen sich Uberschneiden sollen, miissen diese ggf. verlangert
werden. In einigen Fallen ist es notwendig, die Freiform-Flachen nach dem
Verlangern erneut einzupassen.

e Falls nétig, kbnnen Sie einer vorhandenen Flache eine Domadne zuweisen, um sie
einzupassen, oder um die Abweichungsdiagnose anzusehen.

Hinweis: In einigen Fallen ist es nitzlich, mit Hilfe von Facettendarstellung oder
anderer erforderlicher Geometrie Bezugselemente zu erzeugen. Sie kénnen
Bezugsebenen und -Achsen als Richtungsreferenz fiir die analytische
Flachenerzeugung und fir Analysen verwenden. Alle in Restyle erzeugten
Bezugselemente (Ebenen, Achsen, Koordinatensystem, Punkte, Kurven)
verwenden die standardmaBige Pro/ENGINEER Benutzeroberflache fir
asynchrone Bezugselemente. Sobald sie jedoch erzeugt wurden, verlieren sie ihre
parametrische KE-Definition und kénnen im Restyle-KE nicht umdefiniert werden.

e Sie kdnnen Kurven oder Flachen ausrichten, um Kurven oder Flachen kontinuierlich
zu positionieren. Sie kdnnen die Bedingungen editieren und entfernen, wenn dies
fur das richtige Andern von einzelnen Flachen und Kurven erforderlich ist.

e Sie kénnen Splineflachen auch automatisch auf einem Facetten-KE erzeugen. Sie
kénnen dann die Flache mit den vorhandenen Werkzeugen fiir Kurven und Flachen
andern.

¢ Verwenden Sie das Werkzeug Diagnose (Diagnostics), um die Eigenschaften von
Flachen und Kurven dynamisch darzustellen.

¢ Um Komponenten des Flachenmodells in Restyle auszublenden, einzublenden oder
zu léschen, verwenden Sie das Werkzeug Restyle-Baum (Restyle Tree).

e Wenn Sie das Restyle-KE fertig gestellt haben, kdnnen Sie die erzeugte Geometrie
zur Erzeugung von herkdmmlichen Pro/ENGINEER KEs verwenden.

So editieren Sie Restyle-KEs

1. Klicken Sie im Modellbaum auf das zu andernde Restyle-KE und dann mit der
rechten Maustaste. Das Kontextmeni wird angezeigt.

2. Klicken Sie auf Definition editieren (Edit Definition) und nehmen Sie die
erforderliche Anderungen vor.
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Allgemeine Einfiihrung: Der Restyle-Baum

Die Hauptmerkmale des Restyle-Baums sind:

Im

Im

Einfache Ansicht von einzelnen Komponenten des Restyle-KEs.

Sie kénnen die Beziehungen und die Folge des Verschmelzens dieser
Komponenten anzeigen. Dadurch kdnnen Sie die Vollstandigkeit des Modells
unter Berlicksichtigung der Konstruktionsabsicht tiberprifen.

Restyle-Baum wird folgendes angezeigt:

Die erzeugten Domanen. Jede Domane ist ein einzelner Knoten des Restyle-
Baums.

Die einzelnen erstellten Flachen. Jede dieser Flachen wird auf Ebene 1 angezeigt.

Die Ergebnisse der Verschmelzung von Komponenten auf untergeordneten
Ebenen. Die Reihenfolge des Schmelzen-/ Schneiden-Vorgangs wird durch eine
Baumstruktur ausgedruickt.

Das Ergebnis der automatischen Flache.

Restyle-Baum kdnnen Sie die folgenden Aufgaben ausfihren:

Ausgewahlte Domanen oder einzelne Flachen I6schen.

Komponenten auf einer Gbergeordneten Ebene I6schen. Beispielsweise einen
Schmelzen-Vorgang entfernen, der diese Komponente erzeugt hat.

Ausgewahlte Domanen und Ubergeordnete Komponenten ausblenden, einblenden
und isolieren.

So verwenden Sie den Restyle-Baum

Klicken Sie auf IE Der Restyle-Baum wird in einem separaten Fenster
angezeigt.

Um den Restyle-Baum auszublenden, klicken Sie erneut auf IE

Klicken Sie auf eine Komponente, um sie im Restyle-Baum auszuwdahlen. Um eine
Komponente zu andern, auszublenden oder zu |6schen, klicken Sie mit der
rechten Maustaste auf die ausgewdhlte Komponente.
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Allgemeine Einfiihrung: Das Dialogfenster "Restyle-Diagnose
(Restyle Diagnostic)"

Beim Andern der Restyle-Gometrie kdnnen Sie die dynamische Anzeige von Analysen
und Diagnosewerkzeugen aktivieren oder deaktivieren. Die dynamische Anzeige wird
entsprechend angepasst, wenn Sie die Geometrie andern.

Es stehen die folgenden Fldchen-Diagnoseoptionen zur Auswahl:

¢ Kosmetische Schattierung (Cosmetic Shading)
e Senkrechten (Normals)

¢ Nadelwalze (Porcupine)

e Netz

e Abweichung (Deviation)

e Referenzpunkte (Reference Points)

Es stehen die folgenden Kurven-Diagnoseoptionen zur Auswahl:

e Radius
e Krimmung

Weitere Analysewerkzeuge finden Sie im Menl Analyse (Analysis).

So verwenden Sie das Dialogfenster "Restyle-Diagnose (Restyle
Diagnostics)"

=

1. Klicken Sie auf li.il. Das Dialogfenster Restyle-Diagnose (Restyle
Diagnostic) wird gedffnet.

2. Klicken Sie aufE und dann auf k , um die Kurven und Flachen auszuwahlen,
die aus der Diagnose entfernt werden sollen.

3. Klicken Sie auf@ und auf K , um die Kurven und Flachen auszuwdhlen, die zu
der Diagnose hinzugefligt werden sollen.

4. Um das Modell mit der Analyse anzuzeigen, wahlen Sie eine Analyse aus der Liste

und klicken Sie auf R . Vergewissern Sie sich, dass das Icon IEI neben der
Analyse im Restyle-Diagnose-Dialogfenster angezeigt wird.

5. Um die Analyse auszublenden, wahlen Sie die Analyse aus dem Fenster und

klicken Sie auf ® 3 . Vergewissern Sie sich, dass das Icon neben der
Analyse im Restyle-Diagnose-Dialogfenster angezeigt wird.

6. Um Einstellungen fir eine bestimmte Analyse zu dndern, wahlen Sie eine Analyse
aus dem Fenster und klicken Sie auf Einstellung (Setting). Im Dialogfenster
Darstellungseinstellungen (Display Settings) konnen Sie Parameter flr die
ausgewahlte Analyse festlegen.
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Hinweis: Die Flachen, die Sie fiir die Vorgdnge Andern (Modify) und Einpassen
(Fit) auswahlen, werden der Diagnose automatisch hinzugefiigt.

Domadnen in Restyle verwalten

Allgemeine Einfiihrung: Domadanen

Eine Domane ist eine Sammlung von Facetten-Eckpunkten, die durch eine oder
mehrere Kurven auf Facetten begrenzt ist. Sie kann zum Definieren von
Referenzpunkten zum Anzeigen einer Abweichung und zum Einpassen von Flachen-
Freiformen verwendet werden. Die Doméane kann auch zum Erzeugen einer teilweise
oder vollstandig analytischen, Profil- oder rotierten Flache verwendet werden. In
diesem Fall wird das Erzeugen der analytischen Flache nur durch die ausgewahlten
Doménen beeinflusst.

So erzeugen Sie eine Domane

1. Klicken Sie auf =21 und wahlen Sie Punkte auf den Facetten, so dass die
resultierende Kurve eine geschlossene Schleife bildet. Sie kdnnen zum Erzeugen
von Domanen auch Kurven verwenden, die aus scharfen Kanten, Randern,
Schnittkurven oder Analysekurven erzeugt wurden. Domanen kénnen auch in
einem Bereich erzeugt werden, der von mehreren Kurven begrenzt wird.

2. Klicken Sie auf und auf eine beliebige Stelle innerhalb der geschlossenen
Schleife. Restyle erzeugt eine Domane und hebt diese hervor.

So fiigen Sie einer Domane eine Schleife hinzu

1. Klicken Sie auf ==,

2. Wahlen Sie Punkte auf der Facetten-Flache, so dass die sich ergebende Kurve
eine Schleife innerhalb der vorhandenen Domane bildet oder die Doméne
schneidet.

3. Klicken Sie auf + , und klicken Sie dann in der urspringlichen Domdne. Wahlen
Sie einen Punkt in dem Bereich, um eine Schleife hinzuzufligen. Das Hinzufligen
einer Schleife schrankt die Domane ein, da die innerhalb des gewahlten Bereichs
befindlichen Punkte ausgeschlossen werden.




Restyle

Beispiel: Einer Domane eine Schleife hinzufiigen
Die folgende Abbildung zeigt eine auf einer Facetten-Flache erzeugte Domane.

Die nachste Abbildung zeigt die gednderte Domdne, nachdem eine Schleife
hinzugefiigt wurde.
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So entfernen Sie eine Schleife aus einer Domane
1. Klicken Sie auf .
2. Klicken Sie in der hervorgehobenen Domane, um sie zu wahlen.

3. Wadhlen Sie den Bereich in den geschlossenen Schleifenkurven, in dem keine
Facetten-Punkte hervorgehoben sind. Die Schleife gilt nicht langer als
Begrenzung der Domane. Restyle hebt die gesamte Domane hervor.

Beispiel: Eine Schleife aus einer Domidne entfernen

Die nachste Abbildung zeigt eine Domane, nachdem ihr eine Schleife hinzugefiigt
wurde, um sie zu beschranken.
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Die nachste Abbildung zeigt die Domane, nachdem die Schlaufe aus ihr entfernt
wurde.
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So verschmelzen Sie Domadnen

1. Klicken Sie auf

2. Klicken Sie in den beiden zusammenzufassenden Domanen. Die als zweites
gewdahlte Domane wird der zuerst gewdhlten Domane angehangt. Die
zusammengefasste Doméane wird hervorgehoben.

So weisen Sie einer Flache eine Domane zu

1. Klicken Sie auf
2. Wadhlen Sie eine Domdne, um sie der Flache zuzuweisen.
3. Wahlen Sie die Flache. Restyle weist die Domane der gewahlten Fléche zu.

Indem Sie einer Flache eine Domdne zuweisen, werden die durch die Domane
festgelegten Facetten-Eckpunkte als Referenzpunkte zur gewahlten Flache
hinzugefligt. Spater kann die Flache an die Referenzpunkte angepasst werden.

Kurven in Restyle erzeugen

Allgemeine Einfiihrung: Kurven in Restyle erzeugen
In Restyle kdnnen Sie Kurven erzeugen, indem Sie Folgendes wahlen:

e Facetten-Punkte

e Frei ausgewadhlte Punkte der Geometrie einschlieBlich Bezugspunkte, Eckpunkte,

Kurven, Flachen und Facettendaten, durch die die Kurve verlauft

11
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Punkte auf einer Flache

Rander oder scharfe Kanten auf dem Facetten-KE

Einen Querschnitt des Facetten-KE an einer Bezugsebene

AuBerdem kénnen Sie mit der Befehlsfolge Einfiigen > Modellbezug > Kurve
(Insert > Model Datum > Curve) Bezugskurven durch Punkte, von einer Datei
aus, mithilfe eines Querschnitts oder durch eine Gleichung erzeugen. Weitere
Informationen finden Sie in der Beschreibung des Part Modeling-Moduls der
Pro/ENGINEER-Dokumentation.

So erzeugen Sie eine Kurve auf Facetten

1. Klicken Sie auf N

2. Wahlen Sie Punkte auf dem Facettemodell, durch die die Kurve verlaufen soll,
und klicken Sie mit der mittleren Maus. Restyle erzeugt eine Kurve, die durch die
gewahlten Punkte auf Facetten verlauft. Die Kurve bleibt selbst dann auf dieser
Facette, wenn Sie sie andern.

Hinweis: Die resultierende Anzahl von Punkten, die die Kurve auf Facetten
definieren, kann u.U. hdher sein als die der tatsachlich gewdahiten Punkte.
Pro/ENGINEER passt die Anzahl der Punkte an, damit die Kurve so nahe wie mdglich
am Facettenmodell bleibt.

So erzeugen Sie eine Kurve auf einer Flache

1. Klicken Sie auf =

2. Wahlen Sie die Flache, auf der Kurven erzeugt werden sollen. Sie kénnen zum
Erzeugen einer Kurve nur eine Flache wahlen.

3. Wahlen Sie Punkte auf der Flache aus, und klicken Sie mit der mittleren
Maustaste. Restyle erzeugt eine Kurve auf der Flache, die durch die ausgewahlten
Punkte verlauft. Die Kurve bleibt selbst dann auf dieser Flache, wenn Sie sie
andern.

So erzeugen Sie eine Schnittkurve
1. Klicken Sie auf .

2. Wadhlen Sie die Bezugsebene aus, die fliir den Schnitt verwendet werden soll.
Pro/ENGINEER erzeugt eine Kurve auf Facetten als einen Schnittpunkt der
Facettendaten und der ausgewdahlten Bezugsebene.

Um ggf. eine Bezugsebene an einer erforderlichen Position zu erzeugen, klicken

Sie auf £ . Das Dialogfenster BEZUGSEBENE (DATUM PLANE) wird gedffnet.
Geben Sie die Platzierungsparameter der Bezugsebene an. Restyle erzeugt eine
Kurve am Querschnitt der Bezugsebene und des facettierten Modells.

12
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Hinweis: Die sich ergebende Kurve ist eine Kurve auf Facetten. Sie kann zum
Erzeugen von Domédnen und zum automatischen AuftragsschweiBen verwendet
werden.

So erzeugen Sie eine Kurve mit einer Flachenkante
Um eine Kurve mit Hilfe einer Flachenkante zu erstellen, wahlen Sie die Flachenkante

und klicken auf =4, Restyle erzeugt eine Positionsbedingung fiir die Flache mit
Bezug zu dieser Kurve.

So erzeugen Sie eine Kurve mit der Analyse - Extremum

1. Analysieren Sie das Facetten-KE mit einem der folgenden Analyse-Tools:
e Schattierte Kriimmung

e Schrage

e Steigung

2. Speichern Sie die berechnete Analyse.

3. Wadhlen Sie die Befehlsfolge Restyle > Kurven >Analyse - Extremum
(Restyle > Curves >Analysis - Extremum), und wahlen Sie die Punkte in den
Facettendaten, die in etwa den Extremwerten der Analyse entsprechen und auf
der gleichen Kurve liegen. Klicken Sie zum Beenden der Auswahl mit der
mittleren Maustaste.

o Wenn Sie nur einen Punkt wahlen, wird eine Kurve erzeugt, die dem lokalen
Extremum der Analyse folgt.

o Bei Auswahl mehrerer Punkte wird eine offene Kurve erzeugt, die in etwa
durch die ausgewahlten Punkte verlauft und dem lokalen Extremum der
Analyse folgt.

Hinweis: Die sich ergebende Kurve ist eine Kurve auf Facetten. Sie kann zum
Erzeugen von Domédnen und zum automatischen AuftragsschweiBen verwendet
werden.

So erzeugen Sie eine Kurve mit der Analyse - Isolinie

1. Analysieren Sie das Facetten-KE mit einem der folgenden Analyse-Tools:
e Schattierte Kriimmung

e Schrage

e Steigung

2. Speichern Sie die berechnete Analyse.

13
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3. Klicken Sie auf IE, und wahlen Sie Punkte auf den facettierten Daten, die
annahernd den erforderlichen Werten (Farbe) der Analyse entsprechen und die
auf der gleichen Kurve liegen. Klicken Sie zum Beenden der Auswahl mit der
mittleren Maustaste.

o Wenn Sie einen einzelnen Punkt auswahlen, wird eine geschlossene Kurve
erzeugt, die dem ausgewahlten Wert der Analyse folgt.

o Bei der Auswahl mehrerer Punkte wird eine offene Kurve erzeugt, die in
etwa durch die gewdhlten Punkte verlauft, wahrend sie demselben
Steigungswinkel folgt.

Hinweis: Die sich ergebende Kurve ist eine Kurve auf Facetten. Sie kann zum
Erzeugen von Domanen und zum automatischen Auftragsschwei3en verwendet
werden.

Beispiel: Analyse - Isolinie

Die folgende Abbildung zeigt das facettierte Modell, unter Verwendung der Analyse
Steigung.

Die folgende Abbildung zeigt die geschlossene Kurve auf dem facettierten Modell,
unter Verwendung der Analyse - Isolinie.
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So erzeugen Sie eine Kurve aus einem Facettenrand
1. Wahlen Sie die Befehlsfolge Restyle > Kurven > Vom Facettenrand (Restyle
> Curves > From Facet Border).

2. Wahlen Sie aus den facettierten Daten Punkte, die auf der gedffneten Berandung
liegen. Klicken Sie zum Beenden der Auswahl mit der mittleren Maustaste.

o Wenn Sie einen einzelnen Punkt auswahlen, wird eine geschlossene Kurve
erzeugt, die der offenen Berandung folgt.

o Bei Auswahl mehrerer Punkte wird eine offene Kurve erzeugt, die in etwa
durch die ausgewdhlten Punkte verlauft und der offenen Berandung folgt.

Hinweis: Die sich ergebende Kurve ist eine Kurve auf Facetten. Sie kann zum

Erzeugen von Domanen und zum automatischen Auftragsschwei3en verwendet
werden.

So erzeugen Sie eine Kurve aus scharfen Facetten-Kanten

ravy
1. Klicken Sie auf .

2. Wahlen Sie aus den facettierten Daten Punkte, die auf der scharfen Kante des

Facettenmodells liegen. Klicken Sie zum Beenden der Auswahl mit der mittleren
Maustaste.

o Wenn Sie einen einzelnen Punkt auswahlen, wird eine Kurve erzeugt, die
der scharfen Kante folgt.

o Bei Auswahl mehrerer Punkte wird eine offene Kurve erzeugt, die in etwa
durch die ausgewahlten Punkte verlauft und der scharfen Kante folgt.

Hinweis: Die sich ergebende Kurve ist eine Kurve auf Facetten. Sie kann zum

Erzeugen von Domanen und zum automatischen Auftragsschwei3en verwendet
werden.
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So erzeugen Sie Kurven durch Punkte

1. Wahlen Sie die Befehlsfolge Restyle > Kurven > Stil (Restyle > Curves >
Style). Die Style-Tool-Leiste wird angezeigt.

2. Erzeugen sie eine Stilkurve auf die Ubliche Art und Weise.

So erzeugen Sie eine freie Kurve, die an Geometrie einrastet

1. Klicken Sie auf 4~ .

2. Wahlen Sie die Punkte der vorhandenen Geometrie, durch die die freie Kurve
verlaufen soll, und klicken Sie mit der mittleren Maustaste. Restyle erzeugt eine
Kurve, die durch die ausgewdahlten Punkte verlauft. Die freie Kurve rastet an der
vorhandenen Geometrie ein.

Hinweis: Einrasten erzeugt keine Bedingungen. Die Kurve andert sich nicht, wenn
sich die vorhandene Geometrie, auf der sie liegt, andert.

Kurven in Restyle verwalten

Allgemeine Einflihrung: Kurven andern

Sie kénnen eine Kurve dndern, indem Sie ihr Steuerpolygon verformen oder ihre
Interpolationspunkte andern.

So dandern Sie eine Kurve

1. Klicken Sie auf , und wahlen Sie die Kurve zum Andern aus. Das Dialogfenster
Kurve dndern (Curve Modify) wird geoffnet.

2. Wahlen Sie eine der folgenden Optionen aus, um die Kurve zu andern:

o Um die Kurve mithilfe ihrer Steuerpunkte zu andern, klicken Sie auf%ﬁg
und wahlen Sie den Eckpunkt des zu verschiebenden Steuerpolygons aus.

o Um die Kurve mithilfe ihrer Interpolationspunkte zu andern, klicken Sie auf

SN

und klicken auf eine der folgenden Optionen:

Bewegen (Move) - Verschiebt die Kurve, indem die Interpolationspunkte
mithilfe der Bewegungsoptionen auf der Kurve verschoben werden.

Hinzufligen (Add) — Filgt der Kurve an der ausgewahlten Position
Interpolationspunkte hinzu.

Loschen (Delete) - Loscht die Interpolationspunkte aus der Kurve durch
Auswahl von Punkten.
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Neu verteilen (Redistribute) - Verteilt die Interpolationspunkte gemafi
der Kurvenkrimmung neu.

Legen Sie bei Bedarf die Bewegungsoptionen fest. Folgende Bewegungsoptionen

sind verfligbar:

o

Kurvenebene (Curve Plane) - Beschrankt die Kurvenbewegung auf die
Kurvenebene. Tangente und senkrechter Vektor der Kurve bilden eine
Ebene.

3. Bewegung (3d Movement) - Bewegt die Kurve frei im 3D-Raum.
Diese Option ist flir Kurven auf Facetten oder Fléachen nicht verfiigbar.

Lokal (Local) - Bewegt nur den ausgewadhlten Steuerpunkt.

Stufenloser Bereich (Smooth Region) - Verschiebt die Steuerpunkte in
einem Abstand relativ zum gewahlten Punkt. Der Abstand der
Punktbewegung verringert sich nach kubischen Gesetzen proportional zu
seinem Abstand vom gewahlten Punkt.

Linearer Bereich (Linear Region) - Verschiebt die Steuerpunkte in
einem Abstand relativ zum gewahlten Punkt. Der Abstand der
Punktbewegung verringert sich nach linearen Gesetzen proportional zu
seinem Abstand vom gewahlten Punkt.

Konstanter Bereich (Constant Region) - Verschiebt alle Steuerpunkte
im gleichen Abstand zum gewaéhlten Punkt. Die Berandung einer
eingespannten Fldache bewegt sich nicht.

Wahlen Sie einen Eckpunkt des Steuer-Polyeder oder die Interpolationspunkte

aus und ziehen Sie sie, um die Kurve zu dndern. Legen Sie die folgenden
Optionen fest, falls eine feinere Steuerung der Punktbewegung erforderlich ist.

o

Senkrechte Richtung (Normal Direction) - Gibt das Inkrement in
senkrechter Richtung an.

Tangentialrichtung (Tangent Direction) - Gibt das Inkrement in
Tangentialrichtung an.

Richtung der Binormalen (Binormal Direction) - Gibt das Inkrement in
der Richtung der Binormalen an. Diese Option ist fur Kurven auf Facetten
oder Flachen nicht verflgbar.

Inkrement (Increment) - Gibt den Wert des Inkrements flr die
Punktbewegung an.

5. Klicken Sie auf E, um die Anderungen an der Kurve abzuschlieBen.
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So projizieren Sie eine Kurve auf ein Facetten-Modell oder eine
Flache

1.

Klicken Sie auf und wahlen Sie eine Kurve, um sie auf das Facetten-Modell zu

projizieren. Sie kdnnen die Kurve auch auswahlen, bevor Sie auf klicken.

Wahlen Sie die facettierte Geometrie oder Flache aus, auf die Sie die Kurve
projizieren mdchten. Wenn facettierte Geometrie (fir Kurve auf Flache) die fir
die Projektion gewdhlte Referenz ist, wahlt Restyle diese automatisch. Andernfalls
werden Sie zur Auswahl von facettierter Geometrie oder einer Flache als Referenz
aufgefordert.

o Wenn Sie eine Kurve auf eine Facette projizieren, wird die projizierte Kurve
als Kurve auf der Facette erzeugt.

o Wenn Sie eine Kurve auf die Flache projizieren, wird die projizierte Kurve
als Kurve auf der Flache erzeugt.

Kurvenbedingungen in Restyle

Allgemeine Einfiihrung: Kurvenbedingungen

Folgende Bedingungen kénnen auf Kurven angewendet werden:
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Position - Eine Positionsbedingung flr eine Kurve liegt vor, wenn das Ende der
Kurve mit einem Punkt einer anderen Kurve definiert ist. Ein Kreis stellt die
Bedingung Position dar.

Tangentenabhdngig (Tangent Dependent) - Wenn Sie eine Bedingung
Tangentenabhdngig (Tangent Dependent) beim Ausrichten von zwei Kurven
wahlen, wird die erste gewahlte Kurve geandert, wahrend die zweite Kurve zur
Referenzkurve wird. Die Bedingung Tangentenabhangig (Tangent
Dependent) legt fest, dass die Tangente am Ende der gedanderten Kurve mit der
Tangente der Referenzkurve ibereinstimmt. Die Kurvenbedingung
Tangentenabhdngig (Tangent Dependent) entspricht dem Prinzip von Grund-
und Folgeelementen. Wenn sich die Form einer Grundkurve andert, passt die
Folgekurve die Form an, um die tangentiale Verbindung zu erhalten. Wenn sich
die Form einer gekoppelten Kurve dndert, ist die Grundelement-Kurve nicht
davon betroffen Die Bedingung Tangentenabhidngig (Tangent Dependent)
wird durch einen Pfeil von der Grundkurve zur Folgekurve dargestellt.

Tangentensymmetrisch (Tangent Symmetric) - Ist mit
Tangentenabhdngig (Tangent Dependent) identisch, allerdings beeinflusst
die eine Kurve nicht die andere Kurve. Die Kurven verhalten sich nicht nach dem
Prinzip von Grund- und Folgeelementen. Die Bedingung
Tangentensymmetrisch (Tangent Symmetric) wird durch eine Linie zwischen
den Kurven dargestellt.
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Kriimmungsabhéangig (Curvature Dependent) - Kriimmungsabhingig
(Curvature Dependent) beim Ausrichten von zwei Kurven wahlen, wird die
erste gewahlte Kurve geandert, wahrend die zweite Kurve zur Referenzkurve
wird. Die Bedingung Kriimmungsabhéangig (Curvature Dependent) legt fest,
dass die Tangente am Ende der geanderten Kurve mit der Krimmung der
Referenzkurve Ubereinstimmt. Die Kurvenbedingung Kriimmungsabhdngig
(Curvature Dependent) entspricht dem Prinzip von Grund- und
Folgeelementen. Wenn sich die Form einer Grundkurve andert, passt die
Folgekurve die Form an, um die Krimmungsverbindung zu erhalten. Wenn sich
die Form einer gekoppelten Kurve d@ndert, ist die Grundelement-Kurve nicht
davon betroffen Die Bedingung Kriimmungsabhédngig (Curvature
Dependent) wird durch zwei Pfeile von der Grundkurve zur Folgekurve
dargestelit.

richten Sie zwei Kurven aus

Klicken Sie auf fl

Wadhlen Sie die erforderliche Bedingung auf der Registerkarte Bedingungen
(Constraints) des Schaltpults aus. Die Kurvenbedingung ist standardmaBig auf
Position gesetzt.

Wahlen Sie eine Kurve. Diese Kurve wird geandert.
Wahlen Sie eine weitere Kurve. Diese Kurve wird zur Referenzkurve.

Beim Ausrichten andert sich die erste Kurve, um sich an die Richtung der
Tangente der zweiten Kurve anzupassen.

Bewegen Sie den Eckpunkt der geanderten Kurve entlang der Referenzkurve an
die gewiinschte Position.

Klicken Sie auf .

bearbeiten Sie Kurvenbedingungen

Kurvenbedingungen kdénnen Sie folgendermaBen bearbeiten:

o
Wahlen Sie eine Kurve aus, und klicken Sie auf ~* . Wahlen Sie alternativ eine

Kurve aus, klicken Sie mit der rechten Maustaste, und wahlen Sie Bedingungen
anzeigen (Display Constraints). Symbole zur Darstellung der Bedingungen
werden zwischen den Kurven angezeigt.

Falls notwendig, kénnen Sie die Kurvenbedingung @ndern. Wahlen Sie eine Kurve
aus, klicken Sie mit der rechten Maustaste, und wahlen Sie Bedingungen
anzeigen (Display Constraints). Wahlen Sie das angezeigte
Bedingungssymbol aus, klicken Sie mit der rechten Maustaste, und wahlen Sie
eine neue Bedingung aus.

Wahlen Sie eine Kurve aus, und klicken Sie auf L\D’, um eine Kurve auf dem
Facetten-KE oder eine Kurve auf der Flache von der Flache abzutrennen. Wahlen
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o

Sie alternativ eine Kurve aus, klicken Sie mit der rechten Maustaste, und wahlen
Sie die Option Abtrennen (Detach).

Falls notwendig, kdnnen Sie die Bedingung auch Iéschen. Wahlen Sie eine Kurve
aus, klicken Sie mit der rechten Maustaste, und wéahlen Sie Bedingungen
anzeigen (Display Constraints). Wahlen Sie das angezeigte
Bedingungssymbol aus, klicken Sie mit der rechten Maustaste, und wahlen Sie
Loschen (Delete) aus.

Wadhlen Sie eine Kurve aus, klicken Sie mit der rechten Maustaste, und wahlen
Sie die Option Form dndern (Modify Shape). Sie kénnen die Form einer Kurve
durch freies Ziehen der Steuerpunkte der Kurve andern.

o Bei einer Positionsbedingung kdnnen Sie die Form von beiden Kurven
unabhangig durch freies Ziehen der Steuerpunkte dndern.

o Bei der Bedingung Tangentenabhdngig (Tangent Dependent) kénnen
Sie die Form der Grundkurve durch freies Ziehen der Steuerpunkte andern.
Sie kénnen nicht den ersten Steuerpunkt des Folgeelements ziehen, und die
Bewegung des zweiten Steuerpunkts ist auf die Richtung der Tangente
beschrankt, die durch das Ende der Grundkurve definiert ist. Sie kdnnen
alle anderen Steuerpunkte auf der gekoppelten Kurve frei ziehen.

o Bei einer Bedingung Tangentensymmetrisch (Tangent Symmetric)
kénnen Sie die Form von beiden Kurven andern, ohne dass dies
Auswirkungen auf die tangentiale Verbindung hat. Erster und zweiter
Steuerpunkt der Folgekurve sind gesperrt, um die tangentiale Verbindung
zu erhalten. Diese Punkte kdnnen nicht gezogen werden. Alle anderen
Steuerpunkte kdénnen Sie frei ziehen.

o Bei einer Bedingung Kriimmungsabhdngig (Curvature Dependent)
kdénnen Sie die Form der Grundkurve durch freies Ziehen der Steuerpunkte
andern. Die ersten drei Steuerpunkte der Folgekurve sind gesperrt, um die
Krimmungsverbindung zu erhalten. Diese Punkte kénnen nicht gezogen
werden. Sie kdnnen alle anderen Steuerpunkte auf der gekoppelten Kurve
frei ziehen.

Ggf. kénnen Sie die Richtung von Grund- und Folgekurve wechseln. Wahlen Sie
eine Kurve aus, klicken Sie mit der rechten Maustaste, und wahlen Sie
Bedingungen anzeigen (Display Constraints). Wahlen Sie das angezeigte
Bedingungssymbol aus, klicken Sie mit der rechten Maustaste, und wéahlen Sie
HWLinie umkehren (Flip Leader) aus.

So verschmelzen Sie Kurven
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Ry
Klicken Sie auf =,

Wahlen Sie eine Kurve.

Wahlen Sie eine weitere Kurve. Die beiden Kurven werden zu einer einzigen
Kurve verschmolzen. Die resultierende Kurve dandert die Form, um die Glattheit
zu erhalten.
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So trennen Sie Kurven

1.

Wahlen Sie eine Kurve.

F
Klicken Sie auf 7~

Wahlen Sie auf der Kurve einen Punkt aus. Die Kurve wird an dem angegebenen
Punkt getrennt. StandardmaéaBig ist die Bedingung zwischen den beiden
resultierenden Kurben am Trennpunkt eine Positionsbedingung.

Analytische Flachen in Restyle erzeugen

Allgemeine Einfiihrung: Analytische Flachen erzeugen

Beim Erzeugen analytischer Flachen ist Folgendes zu beachten:

Sie kénnen erst eine Domane und dann das erforderliche Werkzeug zur
Erzeugung der Fldche wdhlen. Restyle erzeugt die Fldche automatisch. Sie
kdnnen aber auch erst das Werkzeug und dann eine Domane wahlen.

Wenn Sie das Kontrollkdstchen Domane (Domain) aktivieren, wahlen Sie eine
Domaéne aus, um die Flache zu definieren. Andernfalls miissen Sie einen Punkt
auf Facetten wahlen, um eine ebene, zylindrische oder extrudierte Flache zu
erzeugen, oder Sie missen fir eine konische oder gedrehte Flache einen oder
zwei Punkte auf Facetten wahlen. Dies hangt davon ab, ob Sie die Richtung flr
die Erzeugung der Flache festlegen.

Wenn Sie das Kontrollkastchen Vollstandig (Full) aktivieren, wird eine
vollstéandige 360-Grad-Flache fir Zylinder, Kegel oder gedrehte Flachen bzw. fiir
Flachen basierend auf einem geschlossenen Schnitt fur Profilflachen erzeugt. Fir
flache Flachen ist Voll (Full) nicht verfligbar.

Vor der Erzeugung einer analytische Flache kdénnen Sie nur Bezugspunkte als
Ursprungspunkte wahlen. Wenn Sie eine analytische Flache bearbeiten, kénnen
Sie eine beliebige Position auf der Facette als Referenz fiir den Ursprungspunkt
wahlen.

Wenn Sie einen Bezugspunkt fir die Ursprungsreferenz wahlen, wird die
analytische Flache so platziert, dass ihr Ursprungspunkt an seiner endgultigen
Position exakt mit dem gewahlten Bezugspunkt Gbereinstimmt.

Vor der Erzeugung einer Flache kdnnen Sie wahlweise eine Bezugsachse,
Bezugsebene oder Flache wahlen, um die Richtung festzulegen. Flr konische,
zylindrische und gedrehte Flachen wird die Drehachse als Achse definiert.

Nachdem Sie die Flache erstellt haben oder wahrend Sie sie bearbeiten, kénnen
Sie die Koordinaten des Ursprungs und die Richtungswinkel dndern. Sie kénnen
auch die Ursprungsparallele in eine festgelegte Richtung verschieben, indem Sie
einen Punkt auf dem Facetten-Modell wahlen. Dies ist besonders bei Kegelflachen
und extrudierten Flachen mit einem Schragwinkel hilfreich.
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¢ Restyle verwendet das Koordinatensystem, um die Koordinaten des Ursprungs-
und Richtungswinkels neu zu berechnen. Sie kdnnen das Koordinatensystem
angeben, das fiir diese Berechnungen verwendet werden soll. Andernfalls
verwendet Restyle das Standard-Koordinatensystem.

Hinweis: Indem Sie genaue Referenzen wdhlen, z.B. Bezugsachsen oder
Bezugsebenen, erhalten Sie exakte analytische Flachen.

Allgemeine Einfiihrung: Analytische Flachen dandern

Wahlen Sie die vorhandene analytische Flache aus und klicken Sie auf , um das
gleiche Dialogfenster zu 6ffnen, das zur Erzeugung der Flache verwendet wurde.
Verwenden Sie die erforderlichen Optionen im Dialogfenster, um die Fldche zu
andern. Klicken Sie auf , um die geanderte Geometrie anzuzeigen.

Hinweis: Die Optionen Vollstdndig (Full) und Domédne (Domain)sind wahrend
des Anderns einer analytischen Fldche nicht verfiigbar.

Allgemeine Einfiihrung: Flache Flachen erzeugen
Beachten Sie folgendes, wenn Sie mit Restyle eine flache Flache erzeugen:

e Der gewdhlte Punkt ist der Ursprung der flachen Flache.

e Restyle orientiert die flache Flache b_(_ez(]glich der Referenzrichtung. Die
Orientierung der Flache kann durch Andern der WinkelbemaBungen gedndert
werden.

e Sie kénnen flr die Erzeugung der flachen Flache Bezugsebenen, -achsen, -kanten
und Facetten-Flachen als Richtungsreferenzen verwenden.

e Sie kdnnen zwei beliebige WinkelbemaBungen fir die Richtung angeben. Restyle
berechnet die dritte BemaBung anhand dieser zwei BemaBungen.

So erzeugen Sie flache Flachen

1. Klicken Sie auf . Das Dialogfenster Ebene (Plane) wird gedffnet.

2. Aktivieren Sie zum Definieren der Fléche das erforderliche Kontrollkdstchen:
o Voll (Full)—Erzeugt einen vollstédndigen Zylinder von 360 Grad.

o Domadne (Domain)—Erzeugt die Flache anhand der ausgewahlten
Domaéne.

3. Wahlen Sie die Referenzen fiir die flache Flache.

o Koord. System (Coord System) — Wahlen Sie das Koordinatensystem
aus. Dieses Koordinatensystem dient als Referenz zum Bearbeiten oder
Bewegen der Flache.
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o Ursprungspunkt (Origin Point) — Sofern nicht ausdricklich ein anderer
Ursprungspunkt festgelegt wurde, ist der auf der Facette markierte Punkt
der Ursprungspunkt der flachen Flache. Fir analytischen Flachen kénnen
Sie nur Bezugspunkte festlegen, wenn Sie den Ursprungspunkt vor der
Erstellung der Flache definieren mdchten. Nach der Erstellung der Flache
kénnen Sie zur Modifizierung des Ursprungspunkts jede Position auf der
Facette fiir die Definition des Ursprungspunkts auswahlen.

Die Fldache wird senkrecht zu sich selbst verschoben, so dass der
Ursprungspunkt und der Facetten-Punkt auf derselben Ebene liegen.

Restyle zeigt die x-, y- und z-Koordinaten des Ursprungspunkts in den
entsprechenden Feldern Ursprungspunkt-Koordinaten (Origin Point
Coordinates) an. Sie kénnen diese Koordinaten andern, um den
Ursprungspunkt zu verschieben. Die Flachen bewegen sich in Bezug auf den
Ursprungspunkt.

o Richtung (Direction) — Wahlen Sie bei Bedarf eine Bezugsebene oder
eine Achse als Richtungsreferenz aus. Die Orientierung der Flache héngt
von der Richtungsreferenz ab.

Andern Sie unter Richtung WinkelbemaBungen (Direction Angular
Dimensions) mit Hilfe der Richtungsvektoren den Rotationswinkel der flachen
Flache, um diese in die gewlinschte Richtung zu drehen.

Klicken Sie auf .

Allgemeine Einfiihrung: Zylindrische Flachen erzeugen

Beachten Sie folgendes, wenn Sie mit Restyle eine zylindrische Flache erzeugen:

Der Mittelpunkt der Zylinderbasis ist sein Ursprung.

Restyle orientiert die Zylinderflache bezliglich der Referenzrichtung. Die
Orientierung der Flache kann durch Andern der WinkelbemaBungen geéndert
werden.

Sie kédnnen Bezugsebenen und -Achsen als Richtungsreferenz fur die Erstellung
der zylindrischen Flache auswahlen. Wenn Sie eine Achse als Richtungsreferenz
auswahlen, verwendet Restyle diese als Achse des Zylinders. Wenn Sie eine
Ebene auswahlen, berechnet Restyle den Ursprung des Basiskreises automatisch.

Sie kédnnen zwei beliebige WinkelbemaBungen fir die Richtung angeben. Restyle
berechnet die dritte BemaBung anhand dieser zwei BemaBungen.
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So erzeugen Sie eine zylindrische Flache

1.

Klicken Sie auf . Das Dialogfenster Zylinder (Cylinder) wird gedtffnet.

2. Aktivieren Sie zum Definieren der Flache das erforderliche Kontrollkastchen:

o Voll (Full)—Erzeugt einen vollstdndigen Zylinder von 360 Grad.

o Domadne (Domain)—Erzeugt die Flache anhand der ausgewahlten
Domane.

3. Wahlen Sie die Referenzen fir die zylindrische Flache.
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o Koord. System (Coord System) — Wahlen Sie das Koordinatensystem
aus. Dieses Koordinatensystem dient als Referenz zum Bearbeiten oder
Bewegen der Flache.

o Ursprungspunkt (Origin Point)— Der Mittelpunkt des Basiskreises des
Zylinders ist sein Ursprung. Fur analytischen Flachen kdnnen Sie nur
Bezugspunkte festlegen, wenn Sie den Ursprungspunkt vor der Erstellung
der Flache definieren mdchten. Nach der Erstellung der Flache kénnen Sie
zur Modifizierung des Ursprungspunkts jede Position auf der Facette fiir die
Definition des Ursprungspunkts auswahlen.

Die Flache wird entlang der Achse so verschoben, dass in der neuen
Position der Ursprungspunkt der Flache und der Facettenpunkt auf
derselben zur Achse senkrechten Ebene liegen.

Restyle zeigt die x-, y- und z-Koordinaten des Ursprungspunkts in den
entsprechenden Feldern Ursprungspunkt-Koordinaten (Origin Point
Coordinates) an. Sie kénnen diese Koordinaten andern, um den
Ursprungspunkt und die Fldche zu verschieben.

o Richtung (Direction) — Wahlen Sie bei Bedarf eine Bezugsebene oder
eine Achse als Richtungsreferenz aus. Wenn Sie eine Achse fir die
Richtungsreferenz auswahlen, wird diese als eine Achse des Zylinders
verwendet. Die Orientierung der Flache hangt von der Richtungsreferenz
ab.

Geben Sie im Feld Durchmesser (Diameter) einen Wert fir den Durchmesser
des Zylinders ein.

Andern Sie unter Richtung WinkelbemaBungen (Direction Angular
Dimensions) mit Hilfe der Richtungsvektoren den Rotationswinkel der
zylindrischen Flache, um diese in die gewilinschte Richtung zu drehen.

Klicken Sie auf .
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Allgemeine Einfiihrung: Kegelflachen erzeugen

Beachten Sie folgendes, wenn Sie mit Restyle eine Kegelflache erzeugen:

e Der Mittenpunkt des Basiskreises ist der Ursprung.

e Restyle orientiert die Kegelflache beziiglich der Referenzrichtung. Die
Orientierung der Fliache kann durch Andern der WinkelbemaBungen geéndert
werden.

e Sie kénnen Bezugsebenen und -Achsen als Richtungsreferenz flir die Erstellung
der Kegelflache auswahlen. Wenn Sie eine Achse als Richtungsreferenz
auswahlen, verwendet Restyle diese als Achse des Kegels. Wenn Sie eine Ebene
auswahlen, berechnet Restyle den Ursprung des Basiskreises automatisch.

e Sie kdnnen zwei beliebige WinkelbemaBungen flr die Richtung angeben. Restyle
berechnet die dritte BemaBung anhand dieser zwei BemaBungen.

So erzeugen Sie eine Kegelfldche

1. Klicken Sie auf . Das Dialogfenster Kegel (Cone) wird gedffnet.

2. Aktivieren Sie zum Definieren der Flache das erforderliche Kontrollkastchen:

o

o

Voll (Full)—Erzeugt einen vollstdndigen Kegel von 360 Grad.

Domaéane (Domain)—Erzeugt die Flache anhand der ausgewdhlten
Domane.

3. Wahlen Sie die Referenzen fiir die Kegelflache.

o

Koord. System (Coord System) — Wahlen Sie das Koordinatensystem
aus. Dieses Koordinatensystem dient als Referenz zum Bearbeiten oder
Bewegen der Flache.

Ursprungspunkt (Origin Point)— Der Mittelpunkt des Basiskreises des
Kegels ist sein Ursprung. Fir analytischen Flachen kénnen Sie nur
Bezugspunkte festlegen, wenn Sie den Ursprungspunkt vor der Erstellung
der Flache definieren mochten. Nach der Erstellung der Flache kénnen Sie
zur Modifizierung des Ursprungspunkts jede Position auf der Facette fiir die
Definition des Ursprungspunkts auswahlen.

Die Flache wird entlang der Achse so verschoben, dass in der neuen
Position der Ursprungspunkt der Flache und der Facettenpunkt auf
derselben zur Achse senkrechten Ebene liegen.

Restyle zeigt die x-, y- und z-Koordinaten des Ursprungspunkts in den
entsprechenden Feldern Ursprungspunkt-Koordinaten (Origin Point
Coordinates) an. Sie kénnen diese Koordinaten @ndern, um den
Ursprungspunkt und die Flache zu verschieben.
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o Richtung (Direction) — Wahlen Sie bei Bedarf eine Bezugsebene oder
eine Achse als Richtungsreferenz aus. Falls eine Achse flir die Richtung
ausgewahlt ist, wird sie die Achse des Kegels. Die Orientierung der Flache
hangt von der Richtungsreferenz ab.

4. Geben Sie im Feld Durchmesser (Diameter) einen Wert fiir die kreisférmige
Basis der Kegelflache ein.

5. Geben Sie im Dialogfenster Schragenwinkel (Draft Angle) einen Wert fiir den
Schragenwinkel des Kegels ein. Ein Schragenwinkel von mehr als 90 Grad kann
nicht angegeben werden.

6. Geben Sie im Dialogfenster Kegelhéhe (Cone Height) einen Wert fir die Héhe
des Kegels ein.

7. Andern Sie unter Richtung WinkelbemaBungen (Direction Angular
Dimensions) mit Hilfe der Richtungsvektoren den Rotationswinkel der
Kegelflache, um diese in die gewlnschte Richtung zu drehen.

8. Klicken Sie auf .

So erzeugen Sie eine gedrehte Flache

1. Klicken Sie auf @ Das Dialogfenster Drehflache (RevolSurface) wird
gedffnet.

2. Aktivieren Sie zum Definieren der Flache das erforderliche Kontrollkastchen:
o Voll (Full)—Erzeugt eine gedrehte Flache von 360 Grad.

o Domadne (Domain)—Erzeugt die Flache anhand der ausgewadhlten
Domane.

3. Wahlen Sie die Referenzen fiir die gedrehte Flache.

o Koord. System (Coord System) — Wahlen Sie das Koordinatensystem
aus. Dieses Koordinatensystem dient als Referenz zum Bearbeiten oder
Bewegen der Flache.

o Ursprungspunkt (Origin Point)— Der Mittelpunkt des Basiskreises, die
der gedrehte Schnitt nach der Drehung bildet, ist der Ursprung der
gedrehten Flache. Fir analytischen Flachen kénnen Sie nur Bezugspunkte
festlegen, wenn Sie den Ursprungspunkt vor der Erstellung der Flache
definieren méchten. Nach der Erstellung der Flache kdnnen Sie zur
Modifizierung des Ursprungspunkts jede Position auf der Facette fir die
Definition des Ursprungspunkts auswahlen.

Die Flache wird entlang der Achse so verschoben, dass in der neuen
Position der Ursprungspunkt der Flache und der Facettenpunkt auf
derselben zur Achse senkrechten Ebene liegen.

Restyle zeigt die x-, y- und z-Koordinaten des Ursprungspunkts in den
entsprechenden Feldern Ursprungspunkt-Koordinaten (Origin Point
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Coordinates) an. Sie kdnnen diese Koordinaten andern, um den
Ursprungspunkt und die Fléache zu verschieben.

o Richtung (Direction) — Wahlen Sie bei Bedarf eine Bezugsebene oder
eine ebene Flache als Richtungsreferenz. Wenn Sie eine Achse als Referenz
auswahlen, verwendet Restyle diese als Rotationsachse und erzeugt eine
Querschnittkurve oder eine Kurvenkette. Um die Flache zu begrenzen,
werden Sie aufgefordert, zwei Punkte auf der Kurve auszuwahlen. Falls Sie
keinen Punkt auswahlen, verwendet Restyle zur Erstellung der Fléache die
gesamte Kurve. Die Richtung der Drehung wird durch die Richtung der
Achse und durch die Rechte-Hand-Regel definiert. Die Orientierung der
Flache hangt von der Richtungsreferenz ab.

4. Andern Sie unter Richtung WinkelbemaBungen (Direction Angular
Dimensions) mit Hilfe der Richtungsvektoren den Rotationswinkel der gedrehten
Flache, um diese in die gewlinschte Richtung zu drehen.

5. Klicken Sie auf , um die erzeugte Schnittkurve auszuwéhlen. Andern Sie die
Schnittkurve anschlieBend mit den Skizzierer-Tools, um die Flache einzupassen.
Nach der erfolgreichen Modifizierung des Schnitts behalt Restyle keine fiir die
BemaBung oder Ausrichtung verwendeten Referenzen bei. Dies bedeutet, bei
einer erneuten Modifizierung des Schnittes wird der gesamte bemafBte Schnitt mit
Bezug auf ein Koordinatensystem (ber dem Ursprungspunkt angezeigt.

6. Klicken Sie auf .

So erzeugen Sie eine Profilflache

[
1. Klicken Sie auf . Das Dialogfenster Profilkérper (Extrusion) wird geéffnet.
2. Aktivieren Sie zum Definieren der Flache das erforderliche Kontrollkastchen:
o Voll (Full)—Erzeugt einen Profilkérper mit einem geschlossenen Schnitt.

o Domadne (Domain)—Erzeugt und begrenzt die Flache anhand der
ausgewahlten Domane.

3. Wahlen Sie die Referenzen flr die Profilflache.

o Koord. System (Coord System) — Wahlen Sie das Koordinatensystem
aus. Dieses Koordinatensystem dient als Referenz zum Bearbeiten oder
Bewegen der Flache.

o Ursprungspunkt (Origin Point)— Der Punkt auf der Basisebene der
extrudierten Flache ist ihr Ursprung. Fur analytischen Flachen kénnen Sie
nur Bezugspunkte festlegen, wenn Sie den Ursprungspunkt vor der
Erstellung der Flache definieren mdchten. Nach der Erstellung der Flache
kénnen Sie zur Modifizierung des Ursprungspunkts jede Position auf der
Facette flr die Definition des Ursprungspunkts auswahlen.

27



Hilfethemensammlung - Restyle

Die Flache wird senkrecht zur Schnittebene verschoben, so dass der
Ursprungspunkt der Flache und der gewahlte Facetten-Punkt an der neuen
Position auf derselben Schnittebene liegen.

Restyle zeigt die x-, y- und z-Koordinaten des Ursprungspunkts in den
entsprechenden Feldern Ursprungspunkt-Koordinaten (Origin Point
Coordinates) an. Sie kédnnen diese andern, um den Ursprungspunkt und
die Flache zu verschieben.

o Richtung (Direction) — Wahlen Sie bei Bedarf eine Bezugsebene oder
eine ebene Flache als Richtungsreferenz. Die Orientierung der Flache hangt
von der Richtungsreferenz ab.

Geben Sie im Dialogfenster Schragenwinkel (Draft Angle) einen Wert flir den
Schragenwinkel der Flache ein, falls erforderlich. Sie kénnen den Schragenwinkel
auch nach der Erzeugung der Flache andern. Die Neutralebene der Schrage
entspricht der Ebene, auf der sich der Ursprung befindet.

Andern Sie unter Richtung WinkelbemaBungen (Direction Angular
Dimensions) mit Hilfe der Richtungsvektoren den Rotationswinkel der gedrehten
Flache, um diese in die gewlinschte Richtung zu drehen.

Klicken Sie auf , um die erzeugte Schnittkurve auszuwéhlen. Andern Sie die
Schnittkurve anschlieBend mit den Skizzierer-Tools, um die Flache einzupassen.
Nach der erfolgreichen Modifizierung des Schnitts behalt Restyle keine fiir die
BemaBung oder Ausrichtung verwendeten Referenzen bei. Dies bedeutet, bei
einer erneuten Modifizierung des Schnittes wird der gesamte bemaBte Schnitt mit
Bezug auf ein Koordinatensystem (ber dem Ursprungspunkt angezeigt.

Klicken Sie auf .

Polynomfldachen in Restyle erzeugen

Allgemeine Einfiihrung: Flachen in Restyle erzeugen

In Restyle kénnen Sie folgendes erzeugen:
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Eine rechteckige Fléche, die vier Kurven als Berandung verwendet.
Eine dreieckige Flache, die drei Kurven als Berandung verwendet.

Eine Flache, die die festgelegten Kurven in der ersten und zweiten Richtung
verwendet.

Eine rechteckige Fléche, die drei Kurven als Berandung an drei Seiten verwendet.
Eine rechteckige Fléche, die vier Punkte als Eckpunkte verwendet.

Eine rechteckige Flache, die vier Punkte an einem Kreuz verwendet. Jeder dieser
Punkte liegt an den Mittenpunkten der Seiten der rechteckigen Flache.

Eine rechteckige Flache, die eine Feldauswahl verwendet.
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e Eine rechteckige Flache, die zwei Kurven als Berandung verwendet.
e Eine ausgetragene Flache, die die definierten Kurven verwendet.

Hinweis: Beim Auswahlen von mehreren Kurven, z.B. von vier Kurven fir die
Erzeugung einer Flache, oder beim Auswahlen von mehreren Kurven in einer
Richtung, driicken Sie die STRG-Taste und wahlen Sie die erforderlichen Kurven.

Allgemeine Einfiihrung: Mathematische Eigenschaften von Flachen
festlegen

Fir Polynomflachen, die mit vier Punkten, den Endpunkten eines Kreuzes und einer
Flache aus einem Auswahlrechteck erzeugt wurden, kénnen Sie die mathematischen
Eigenschaften der Flache auf dem Restyle-Schaltpult festlegen.

Sie kénnen einen der folgenden Flachentypen aus der Liste Flachentyp (Surface
Type) auf dem Restyle-Schaltpult auswahlen:

o Splines - Der Standard-Flachentyp. Wenn Sie diesen Flachentyp wahlen, kédnnen
Sie nur die Anzahl der Segmente andern. Erhéhen Sie die Anzahl von Punkten,
um die Flache besser einzupassen, zu projizieren und an Positions- oder
Tangentialbeschrankungen anzupassen. Wahlen Sie diesen Flachetyp flr
organische Formen und eingespannte Fldachen, z.B. Verrundungen.

e Bezier - Wenn Sie diesen Flachentyp wahlen, kénnen Sie nur den Grad andern.
Erhéhen Sie den Grad fiir eine bessere Einpassung. Dieser Flachentyp eignet sich
nicht flir eingespannte Flachen. Verwenden Sie diesen Flachentyp fir groBe und
glatte Flachen. Mit einer Bezier-Flache kénnen Sie die beste Flachenqualitat
erzielen.

e Bspline - Wenn Sie diesen Flachentyp wahlen, kénnen Sie den Grad und die
Anzahl der Segmente steuern. Mit einem geringeren Grad und mehr Segmenten
erhalten Sie eine Flache, die einer Spline-Flache gleicht. Mit einem héheren Grad
und weniger Segmenten erhalten Sie eine Flache, die einer Bezier-Flache gleicht.

Nachdem Sie eine Flache erzeugt haben, kénnen Sie die Definition der Flache

andern, indem Sie auf. klicken und die Flacheneigenschaften im Dialogfenster
Eigenschaften (Properties) édndern. Beachten Sie beim Andern der
Flacheneigenschaften folgendes:

e Mit zunehmender Anzahl von Segmenten oder einem héheren Grad wird die
Flache flexibler. Dies bedeutet, dass IThnen beim Editieren der Flache mehr
Steuerpunkte zur Verfligung stehen, die eine bessere Steuerung ermdglichen.
Diese Flachen folgen den Facetten-Daten sehr genau und kdénnen exakter
eingepasst werden.

e Durch weniger Segmente oder einen geringeren Grad werden Flachen steifer, da
weniger Steuerpunkte vorhanden sind. Diese Flachen erscheinen glatter und
ansprechender. Aus Herstellersicht eignen sie sich besser.

e Je nach Anforderungen kénnen Sie einen Kompromiss zwischen exakteren Daten
(mehr Punkte, héherer Grad) und der Qualitat einer Flache (weniger Punkte,
geringerer Grad) eingehen.
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Wenn Sie den Grad und Typ einer Flache auf dem Schaltpult gewahlt haben, wird
die letzte Eingabe als Standardeinstellung beim Erstellen der nachsten Flache
verwendet.

So erzeugen Sie eine rechteckige Flache mit vier Kurven

1.
2.

Klicken Sie auf IEI
Wahlen Sie vier Kurven, um eine rechteckige Flache zu erzeugen.

Um die richtige Flache zu erhalten, wahlen Sie bei gedriickter STRG-Taste
zunachst zwei Kurven in der ersten Richtung und anschlieBend genauso die
beiden anderen Kurven in der zweiten Richtung.

Falls die Kurven keine geschlossene Schleife bilden, andert Restyle die Kurven
der ersten Richtung so, dass sich eine geschlossene Schleife ergibt, aus der eine
Fldche erzeugt werden kann. Restyle erzeugt eine Flache, die durch diese Kurven
begrenzt ist.

So erzeugen Sie eine dreieckige Flache mit drei Kurven

1.
2.

Klicken Sie auf @

Wahlen Sie zur Erzeugung einer dreieckigen Fléche drei Kurven so, dass diese
Kurven eine geschlossene Berandung bilden. Gehen Sie dazu folgendermaBen
vor:

o Halten Sie die STRG-Taste gedriickt, und wahlen Sie zwei Kurven in der
ersten Richtung der Flache. Der Schnittpunkt der beiden Kurven ist der Pol
der dreieckigen Flache.

o Wahlen Sie eine Kurve in der zweiten Richtung der Flache.

Restyle erzeugt eine Flache, die von den ausgewahlten Kurven begrenzt ist.

So erzeugen Sie eine Flache aus einem Netz
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Klicken Sie auf .

Driicken Sie die STRG-Taste und wahlen Sie die Kurven in der ersten Richtung.
Klicken Sie mit der mittleren Maustaste, um die Kurvenauswahl abzuschlieBen.

Wahlen Sie die Kurven in der zweiten Richtung auf die gleiche Weise. Restyle
erzeugt mit den ausgewahlten Kurven eine Flache. Klicken Sie mit der mittleren
Maustaste, um die Kurvenauswahl abzuschlieBen.
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So erzeugen Sie eine rechteckige Flache mit drei Kurven

1. Klicken Sie auf .

2. Wahlen Sie drei Kurven, um eine rechteckige Flache zu erzeugen. Um die richtige
Flache zu erhalten, wahlen Sie bei gedriickter STRG-Taste zunachst zwei Kurven
in der ersten Richtung und anschlieBend die dritte Kurve.

Restyle erzeugt eine Flache, die von den ausgewahlten Kurven auf drei Seiten
begrenzt ist.

So erzeugen Sie eine Flache aus einem Rechteck

1. Klicken Sie auf .

2. Klicken und ziehen Sie, um ein rechteckiges Feld zu erstellen. Restyle erzeugt
eine Flache, die der Projektion des Auswahlrechtecks auf die Facettendaten
annahernd folgt.

So erzeugen Sie eine rechteckige Flache anhand von vier Punkten

1. Klicken Sie auf B

2. Wahlen Sie bei gedrickter STRG-Taste vier Punkte auf der facettierten
Geometrie, um eine rechteckige Flache zu erzeugen. Restyle verwendet diese vier
Punkte, um die Berandungskurven zu erzeugen, und erstellt so eine rechteckige
Flache.

So erzeugen Sie eine rechteckige Flache mit den Endpunkten eines
Kreuzes

1. Klicken Sie auf @

2. Dricken Sie die STRG-Taste und wahlen Sie vier Punkte. Restyle erzeugt eine
rechteckige Flache, bei der jede Berandung einen der ausgewahlten Punkte
annahernd am Berandungsmittelpunkt besitzt.

So erzeugen Sie eine rechteckige Flache mit zwei Kurven
1. Klicken Sie auf Ig]

2. Wahlen Sie zwei Kurven, um eine rechteckige Flache zu erzeugen. Restyle
erzeugt mit diesen beiden Kurven eine Flache.

o Falls sich diese beiden Kurven schneiden, erzeugt Restyle eine Flache, bei
der die beiden Kurven die angrenzenden Seiten der rechteckigen Fléche
bilden.
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o Falls sich die beiden Kurven nicht schneiden, erzeugt Restyle eine
rechteckige Flache, die die zuerst ausgewahlte Kurve als Seite verwendet.
Die an diese Kurve angrenzende Seite verlauft in der gleichen Richtung wie
die zweite Kurve.

So erzeugen Sie eine ausgetragene Flache mit den definierten
Kurven

1. Klicken Sie auf .

2. Wahlen Sie bei gedriickter STRG-Taste Kurven, ohne die Auswahlrichtung zu
andern, um die Flache zu erstellen, und klicken Sie auf OK. Restyle erzeugt eine
ausgetragene Flache, so dass diese Kurven vollstandig auf der Fléche liegen.

Splineflachen automatisch erzeugen

Allgemeine Einflihrung: Splineflachen automatisch erzeugen

Die automatische Erzeugung von Splineflachen erméglicht Ihnen das automatische
Erzeugen von Flachengeometrie auf einem Facetten-KE.

Die automatische Erzeugung von Splineflachen umfasst drei Phasen:

e Definieren einer Schleife, die den Bereich der zu erzeugenden Flache bestimmt
e Definieren der Einzelflachenstruktur

e Erzeugen oder Andern der Fliche

Sie kénnen die Flache mit den vorhandenen Werkzeugen fiir Kurven und Flachen
andern.

Hinweis: Sie kénnen die Flache mit der Befehlsfolge Editieren > Definition (Edit
> Definition) neu definieren.

So erzeugen Sie automatisch Splineflachen

1. Klicken Sie auf Q

2. Klicken Sie auf Q auf dem Schaltpult, um eine Flache Gber dem gesamten

facettierten Modell zu erzeugen, oder klicken Sie auf E:_LJ auf dem Schaltpult, um
eine Flache Uber einem ausgewahlten geschlossenen Schleifenbereich auf dem
Facetten-KE zu erzeugen.

3. Zum Auswahlen von Konturkurven, die einen geschlossenen Schleifenbereich

definieren, klicken Sie auf + auf dem Schaltpult und wahlen die erforderlichen
Kurven aus. Die Konturkurven bilden eine geschlossene Kurvenberandung. Nach
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dem Auswahlen einer glltigen Schleife werden Pfeile auf dieser Schleife
angezeigt, welche die Standardseite darstellen, die zum Erzeugen der Fléche

ausgewahlt wird. Klicken Sie ggdf. auf auf dem Schaltpult, um die Seite zu
wechseln, auf der die Einzelflachenstruktur erzeugt wird.

Wenn die Konturkurven eine Schleife bilden, die innerhalb der Hauptschleife liegt,
wird der Bereich innerhalb der Schleife aus dem geschlossenen Schleifenbereich
ausgeschlossen.

Zum Entfernen von Konturkrven aus dem geschlossenen Schleifenbereich klicken

Sie auf — auf dem Schaltpult und wahlen die Kurven aus.

StandardmaBig wird eine Einzelflachenstruktur auf der Seite erzeugt, die durch
den Pfeil auf der ausgewahlten Schleife dargestellt wird.

Klicken Sie auf H}'\, um mit dem Erzeugen der Einzelflachenstruktur zu beginnen.

Klicken Sie ggf. auf Einstellungen (Settings) auf dem Schaltpult, und legen Sie
die Werte fiir die Kurvengenerierungs-Einstellungen fest. Geben Sie eine positive
ganze Zahl fir die Kérnigkeit (Granularity) und eine Zahl zwischen 0 und 1 fir
die Zeichen-Ebene (Character Level) ein.

Sie kdnnen die Einzelflachenstruktur folgendermafBen erzeugen:
Sie kénnen die Einzelflachenstruktur durch Auswahlen der internen Kurven
erzeugen.
o Klicken Sie zum Bezeichnen einer Kurve als Innenkurve auf + auf dem
Schaltpult, und wahlen Sie die Kurve aus.
o Klicken Sie zum Entfernen einer Kurve aus den ausgewadhlten internen

Kurven auf — auf dem Schaltpult, und wahlen Sie die Kurve aus.

Hinweis: Die als Innenkurven bezeichneten Kurven werden in die
Einzelflachenstruktur eingeschlossen. Die aus den ausgewadhlten internen Kurven
entfernten Kurven werden aus der Einzelflachenstruktur ausgeschlossen.

Wenn die ausgewahlten Kurven die Kriterien fur eine Einzelflachenstuktur erftllen
und keine weitere Unterteilung erforderlich ist, fahren Sie mit Schritt 8 fort.

Ggf. kédnnen Sie folgendermaBen automatisch weitere Einzelflachen erzeugen:

a. Legen Sie die Anzahl der Einzelflachen im Feld Einzelflaichen hinzuf (Add
Patches) auf dem Schaltpult fest. Die Gesamtanzahl von Einzelflachen, die
in der Einzelflachenstruktur erzeugt werden, entspricht in etwa der Anzahl,
die im Feld Einzelflachen hinzuf (Add Patches) festgelegt wird.

b. Klicken Sie auf '\ Die Einzelflachenstruktur wird automatisch erzeugt.

Wenn Sie mit der Einzelflachenstruktur zufrieden sind, kdnnen Sie direkt
mit dem Erzeugen der Flache fortfahren.
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10.

11.

12.

13.
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c. Wahlen Sie ggf. die Befehlsfolge Editieren > Widerrufen (Edit > Undo),
um die neu erzeugte Einzelflachenstruktur zu entfernen. Legen Sie im Feld
Einzelflachen hinzuf (Add Patches) einen neuen Wert fest, und andern
Sie die Werte fiur die Geomagic-Parameter, um die Einzelflachenstruktur zu
regenerieren. Wiederholen Sie diesen Schritt, bis Sie eine bessere
Einzelflachenstruktur erhalten.

Wenn eine Kurve in der Einzelflachenstruktur eine Tangentenbedingung aufweist,
sind die Flachen, die diese Kurve als gemeinsame Berandung haben, zueinander
tangential. In diesem Fall wird eine symmetrische Tangentialitdt zwischen den
Flachen angewendet. Die Bedingung ist standardmaBig auf Tangente gesetzt.

Gdgf. kbnnen Sie die Kurvenbedingung andern, indem Sie auf die erforderliche
Bedingung auf der Registerkarte Bedingungen (Constraints) auf dem
Schaltpult klicken und die Innenkurve auswahlen. Alternativ kénnen Sie eine oder
mehrere Innenkurven auswdahlen und die erforderliche Bedingung auswahlen.

Hinweis:

o Die Tangentialbedingung wird schwarz und die Positionsbedingung rot
angezeigt.

o Sie kdénnen auf 5 klicken und Schritt 2 bis 10 wiederholen, um die
geschlossene Schleifenkurvenberandung und die Einzelflachenstruktur

umzudefinieren.

Klicken Sie auf [’_J, um mit dem Erzeugen der Fléche zu beginnen.

Optimieren Sie ggf. mit dem Schieber Auflosung (Resolution) die Qualitat der
Flache.

Aktivieren Sie das Kontrollkdastchen Facetten-KE-UnregelmaBigkeiten
einschlieBen (Include facet feature irregularities), um die Flachen auf das
Facetten-KE zu projizieren. Deaktivieren Sie das Kontrollkdstchen Facetten-KE-
UnregelmaBigkeiten einschlieBen (Include facet feature irregularities),
um die Flachen unverandert zu belassen. Das Kontrollkdstchen Facetten-KE-
UnregelmaiBigkeiten einschlieBen (Include facet feature irregularities) ist
standardmaBig aktiviert.

Klicken Sie auf ’\ Die Flache wird automatisch aus der Einzelflachenstruktur
erzeugt.

Hinweis: Sie kénnen auf 2 klicken und Schritt 6 bis 14 wiederholen, um
Einzelflachenstruktur und Flache umzudefinieren.

Klicken Sie auf .
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Kurvengenerierungs-Einstellungen

Mit Einstellungen (Settings) im Schaltpult kénnen Sie Werte fir die
Kurvengenerierung festlegen. Diese Option legt die Kérnigkeit und die Zeichen-Ebene
fur die Flache des Modells fest.

e Kornigkeit

Die Koérnigkeit stellt die Anzahl der méglichen KEs oder Kurven fir eine
Modellflache dar. Ein héherer Wert flir die Kérnigkeit bedeutet, dass Sie mehr
Kurven wahlen missen. Wahlen Sie keinen zu hohen Kérnigkeitswert. Andernfalls
entstehen u.U. zu viele Stérungen beim Auswahlen einer groBen Anzahl von
Kurven.

e Zeichen-Ebene

Der Wert, der fir die Zeichen-Ebene angegeben wird, legt die Krimmung fest,
die erforderlich ist, damit eine Linie als Kurve bezeichnet werden kann. Ein
héherer Wert fir die Krimmung erfordert eine starkere Krimmung der Linie (auf
der Modellflache), damit diese als eine Kurve bezeichnet werden kann.

Flachen in Restyle verwalten

Allgemeine Einfiihrung: Flachen verschmelzen und schneiden

Sie kdnnen in Restyle zwei angrenzende oder sich schneidende Flachen
verschmelzen.

Nach der Verschmelzung erscheint die daraus resultierende Sammelflache als
Komponente in der nachsten Ebene im Restyle-Baum. Deren Definition kann nicht
geandert werden. Wenn Sie eine der Quell-Sammelflachen andern, wird die
resultierende Sammelflache geandert und automatisch aktualisiert. Falls die
Aktualisierung nicht erfolgreich war, entfernt Restyle die resultierende Komponente
und alle Komponenten auf der (ibergeordneten Ebene im Restyle-Baum.

So verschmelzen oder schneiden Sie Flachen
Wahlen Sie zwei Sammelflachen, die zusammengefasst werden oder sich

Uberschneiden sollen, und klicken Sie auf . Indem Sie auf Referenzen
(References) klicken, werden die Namen der gewahlten Sammelflachen angezeigt.

Informationen zum Verschmelzen zweier Flachen oder Sammelflachen finden Sie im
Thema "Allgemeine Einfihrung: Verschmelzungs-KEs" des Moduls "Modellierung von
Bauteilen" der Pro/ENGINEER Hilfe.

Hinweis:

e Die Flachenilberschneidung wird entfernt, wenn eine der (ibergeordneten
Sammelflachen so geandert wird, dass die Zusammenfassung nicht erfolgen
kann. (Beispiel: Wenn die Kante der Sammelflache so extrapoliert wird, dass sie
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sich nicht mehr lGberschneidet, wird die sonst folgende Flachenliberschneidung
entfernt.)

e Die primdre Sammelflache wird die Eltern-Sammelflache des Verschmelz-KE.

So projizieren Sie eine Flache auf ein Facetten-Modell

Klicken Sie auf , und wahlen Sie eine Flache, um sie auf das Facetten-Modell zu
projizieren.

Allgemeine Einfiihrung: Flachen dandern

Sie kénnen die Form einer Polynomflache @ndern, indem Sie eine Flache mithilfe
ihrer Steuer-Polyeder verformen.

So dandern Sie eine Flache

1. Klicken Sie auf .

2. Wadhlen Sie die zu dndernde Flache. Das Dialogfenster Flache andern (Surface
Modify) wird gedffnet.

Hinweis: Falls Sie eine analytische oder verfahrenstechnische Flache zum
Andern auswahlen, wird das gleiche Dialogfenster gedffnet, das zur Erzeugung
der Flache verwendet wird.

3. Wahlen Sie die Richtung fir die Bewegung von Punkten auf der Flache. Die
Optionen sind:

o Senkrechte Richtung (Normal Direction)—Bewegt die Punkte relativ zur
Richtung der Ansicht.

o In Richtung der Fla (In Surf Direction)—Bewegt die Punkte relativ zur
Flache.

4. Legen Sie die Richtung flir das Verformen der Flache fest. Sie kénnen die Flache
in eine oder zwei Richtungen verformen. Fur zwei Richtungen kdénnen Sie eine
Kombination aus einer der folgenden zwei Optionen verwenden.

Folgende Bewegungsoptionen sind verfligbar:
o Local—Nur der ausgewahlte Punkt wird bewegt.

o Stufenloser Bereich (Smooth Region)—Verschiebt die an den
ausgewahlten Punkt angrenzenden Punkte in einem Abstand relativ zum
ausgewahlten Punkt. Der Abstand der Punktbewegung verringert sich nach
kubischen Gesetzen proportional zu seinem Abstand vom gewahlten Punkt.

o Linearer Bereich (Linear Region)—Verschiebt die an den ausgewahlten
Punkt angrenzenden Punkte in einem Abstand relativ zum ausgewahlten
Punkt. Der Abstand der Punktbewegung verringert sich nach linearen
Gesetzen proportional zu seinem Abstand vom gewahlten Punkt.
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o Konstanter Bereich (Constant Region)—Bewegt alle Punkte auf der
Flache im gleichen Abstand vom ausgewadhlten Punkt. Die Berandung einer
eingespannten Flache bewegt sich nicht.

5. Wahlen Sie einen Eckpunkt des Steuer-Polyeder aus und ziehen Sie ihn, um die
Flache zu verformen.

6. Legen Sie die folgenden Optionen fest, falls eine feinere Steuerung der
Punktbewegung erforderlich ist.

o Inkrement — Legt den Inkrement fir die Punktbewegung fest.

o Senkrechte Richtung (Normal Direction) — Legt den Inkrement in der
senkrechten Richtung fest.

o Erste Richtung — Legt den Inkrement in der ersten Richtung fest.

o 2Zweite Richtung — Legt den Inkrement in der zweiten Richtung fest.

7. Klicken Sie auf , um die Flachenanderungen abzuschlieBen.

So extrapolieren Sie eine Flache

1. Klicken Sie auf IE

2. Wahlen Sie die Flache, die extrapoliert werden soll. Die gewahlte Flache wird
hervorgehoben.

3. Wahlen und ziehen Sie die Kante, von der aus die Flache extrapoliert werden soll.
Die Flache wird entlang der ausgewahlten Kante extrapoliert.

4. Um eine Flache zu dehnen, kénnen Sie wahlweise den Verlangerungsmodus
(Extent Mode) auf dem Schaltpult zu Dehnen (Stretch) wechseln.

Hinweis: Wenn Sie eine bereits zusammengefasste Flache extrapolieren, werden
die Flachenuberschneidungen voriibergehend entfernt. Nachdem die
Extrapolierung aufgehoben ist, stellt Restyle die Flachenliberschneidungen wieder
her.

So richten Sie Referenzpunkte ein

1. Klicken Sie auf . Das Dialogfenster Referenzpunkte (Reference Points)
wird gedffnet.

2. Klicken Sie auf Refer Punkte hinzufiigen (Add Ref Points), um Referenzen
hinzuzufligen.

3. Um Referenzpunkte anzugeben, wahlen Sie eine Option aus der Liste.

o Rohdatensatz (Raw Data Set) - Wahlt Punkte aus einem Rohdatensatz.
Wenn Sie die Option Rohdatensatz (Raw Data Set) gewdhlt haben, wird
das Menlu ABTASTFILTER (SCAN FILTER) angezeigt. Wahlen Sie eine der
folgenden Optionen:
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KrvKettFilter (CrvChainFltr) - Verwendet nur Abtastpunkte innerhalb
des Bereichs, der durch eine offene oder geschlossene Kurvenkette
begrenzt ist. Geben Sie die Kurven, die Abtastpunkte trennen, mit den
Befehlen im Meni KETTE (CHAIN) an, und wahlen Sie dann einen
Abtastsatz.

FlaPrjFilter (SrfProjFltr) - Verwendet nur die Abtastpunkte, die innerhalb
der Begrenzungen der Flache projizieren. Geben Sie den Abtastsatz an, der
auf die Flache projiziert werden soll.

Kein Filter (No Fltr) - Wahlt einen ganzen Abtastsatz aus.

Rohdaten-Punkte (Raw Data Points) - Wahlt einzelne Punkte aus
einem Rohdatensatz.

Einzelpunkt (Single Point) - Wahlt Bezugspunkte.

Bezugspunkt-Array (Datum Point Array) - Wahlt ein vollstandiges
Bezugspunkt-Array.

Facetten-Eckpunkte (Facet Vertices) - Wahlt Eckpunte eines Facetten-
Modells.

Facetteneckpunkte in Kurve (Facet Vertices Inside Curve) - Wahlt
Facetten-Eckpunkte innerhalb einer gewahlten, geschlossenen
Kurvenschleife.

4. Um Referenzpunkte zu entfernen, klicken Sie auf RefPkte entf (Rmv Ref

Points), und wahlen Sie eine Option aus der Liste. Die verfligbaren Optionen
sind: Alle (All), Abtastkurvensatz (Scan Curve Set), Abtastkurvenpunkte
(Scan Curve Points), Einzelpunkt (Single Point), Bezugspunkt-Array
(Datum Point Array), und Nach Abweichungsbereich (By Deviation
Range).

5. Klicken Sie auf .

Hinweis: Wenn die Polynomflache aus Kurven auf Facetten erzeugt wird, so dass
diese eine geschlossene Schleife bilden, weist Restyle alle Facetten-Eckpunkte, die

innerhalb der Schleife liegen, standardmaBig der neu erzeugten Flache zu.

So passen Sie eine Flache ein

1. Klicken Sie auf .

2. Wadhlen Sie die einzupassende Flache. Restyle passt die ausgewadhlte Flache in die

facettierte Geometrie ein.

3. Um die Abweichung der eingepassten Flache von der facettierten Geometrie zu

Uberprifen, klicken Sie ggf. auf . und wahlen im Dialogfenster Restyle-

Diagnose (Restyle Diagnostic) unter Flachen-Diagnose (Surface
Diagnostic) die Option Abweichung (Deviation).
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So editieren Sie die Flacheneigenschaften

1.

Klicken Sie auf , und wahlen Sie die erforderliche Flache aus. Das
Dialogfenster Eigenschaften (Properties) erscheint.

2. Mit diesem Dialogfenster kénnen Sie den Flachentyp, den Grad der Flache und die
Anzahl der Segmente in der U- und V-Richtung anzeigen und andern.
Hinweis:

Die Bezier- und BSpline-Flachen kénnen maximal einen Wert von 15 fir den U-
und V-Grad haben.

Eine BSpline-Flache mit zwei Segmenten (Parametern) in U- und V-Richtung ist
eine Bezier-Flache.

Sie kdnnen die Flacheneigenschaften jeder analytischen Fléache éndern, die nicht
mehrere Komponenten enthdlt. Nachdem die Flacheneigenschaften gedandert
wurden, wird diese Flache zu einer Polynomfldche.

Flachenbedingungen in Restyle

Allgemeine Einfiihrung: Flachenbedingungen

Folgende Flachenbedingungen stehen zur Verfligung:

Position - Eine Flache weist eine Positionsbedingung auf, wenn die Kante der
Flache mit der Kurve auf dieser Kante definiert wird. Die Steuerpunkte auf dieser
Kante kénnen nicht gezogen werden.

Tangentenabhdngig (Tangent Dependent) - Die Fléchen sind durch eine
gemeinsame Berandungskurve definiert und sind zueinander tangential. Bei einer
Bedingung Tangentenabhidngig (Tangent Dependent) entspricht die
Flachenbedingung dem Prinzip von Grund- und Folgeelementen. Andert eine
Grundflache ihre Form, passt die Folgeflache ihre Form an, um die Tangentialitat
zur Grundflache beizubehalten. Die Bedingung Tangentenabhadngig (Tangent
Dependent) wird durch einen Pfeil von der Grund- zur Folgeflache dargestellt.

Tangentensymmetrisch (Tangent Symmetric) - Die Flachen haben eine
gemeinsame Berandung und sind zueinander tangential. Bei einer Bedingung
Tangentensymmetrisch (Tangent Symmetric) wirkt sich eine Anderung an
einer Flache nicht auf die andere Flache aus. Die Flachen verhalten sich nicht
nach dem Prinzip von Grund- und Folgeelementen. Die Bedingung
Tangentensymmetrisch (Tangent Symmetric) wird durch eine Linie zwischen
den Flachen dargestellt.

Kriimmungsabhéangig (Curvature Dependent) - Die Fléchen sind
durchgehend entlang der Berandung tangential und krimmungsstetig
zueinander. Bei einer Bedingung Krimmungsabhadngig (Tangent Dependent)
entspricht die Flachenbedingung dem Prinzip von Grund- und Folgeelementen.
Andert eine Grundelement-Fldche ihre Form, passt die gekoppelte Fléche ihre
Form an die Grundelement-Flache an. Die Bedingung Kriimmungsabhangig
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(Curvature Dependent) wird durch einen Doppelpfeil von der Grund- zur
Folgeflache dargestelit.

So richten Sie zwei Flachen aus

4.

7.

Klicken Sie auf /J\

Wahlen Sie die erforderliche Bedingung auf der Registerkarte Bedingungen
(Constraints) des Schaltpults aus. Die Flachenbedingung ist standardmaBig auf
Position gesetzt.

Wadhlen Sie die Flache aus, die Sie ausrichten mdchten.

Wahlen Sie die freie Kante dieser Flache aus, die Sie ausrichten mdéchten. Wenn
Sie eine Tangential- oder Krimmungsbedingung auswahlen, wird die gewahlte
Flache zur Folgeflache.

Wahlen Sie die Kante der zweiten Flache aus. Wenn Sie eine Tangential- oder
Krimmungsbedingung auswahlen, wird diese Flache zur Grundflache.

Die erste Flache andert ihre Position, um sich an der zweiten Flache auszurichten.

Bewegen Sie die Endpunkte der Kante der ersten Fléache entlang der Kante der
zweiten Flachenkurve an die gewlinschte Position.

Klicken Sie auf .

So bearbeiten Sie Flachenbedingungen

Flachenbedingungen kénnen Sie folgendermaBen bearbeiten:

40

B
Wadhlen Sie eine Flache aus, und klicken Sie auf ~%, um die Bedingungen

anzuzeigen. Wahlen Sie alternativ eine Flache aus, klicken Sie mit der rechten
Maustaste, und wahlen Sie Bedingungen anzeigen (Display Constraints).
Symbole zur Darstellung der Bedingungen zwischen Grund- und Folgeflache
werden angezeigt.

Falls notwendig, kénnen Sie die Flachenbedingung andern. Wadhlen Sie eine
Flache aus, klicken Sie mit der rechten Maustaste, und wdhlen Sie Bedingungen
anzeigen (Display Constraints). Wahlen Sie das angezeigte
Bedingungssymbol aus, klicken Sie mit der rechten Maustaste, und wahlen Sie
eine neue Bedingung aus.

Wahlen Sie eine Flache aus, und klicken Sie auf f’\:}, um die Fldche von den
Bedingungskurven abzutrennen. Wahlen Sie alternativ eine Flache aus, klicken
Sie mit der rechten Maustaste, und wahlen Sie die Option Abtrennen (Detach).

Falls notwendig, kdnnen Sie die Bedingung auch I6schen. Wahlen Sie eine Flache
aus, klicken Sie mit der rechten Maustaste, und wahlen Sie Bedingungen
anzeigen (Display Constraints). Wahlen Sie das angezeigte
Bedingungssymbol aus, klicken Sie mit der rechten Maustaste, und wéahlen Sie
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Loschen (Delete) aus. Dadurch wird die Kante der ausgewahlten Flache von der
Bedingungskurve abgetrennt.

e Wahlen Sie eine Flache aus, klicken Sie mit der rechten Maustaste, und wahlen
Sie die Option Form andern (Modify Shape).

o Bei einer Bedingung Tangentenabhédngig (Tangent Dependent) kdnnen
Sie die Form der Grundflache durch Ziehen der Steuerpunkte der zweiten
Reihe und aller folgenden Reihen @ndern.

Hinweis: Die Steuerpunkte der ersten und zweiten Reihe der Folgeflache
sind gesperrt, um die Tangentenabhangigkeit zu erhalten. Sie kénnen diese
Steuerpunkte nicht ziehen.

o Bei einer Bedingung Tangentensymmetrisch (Tangent Symmetric)
kdnnen Sie die Form beider Flachen andern, indem Sie die Steuerpunkte
der dritten und aller folgenden Reihen ziehen.

Hinweis: Die Steuerpunkte der ersten und zweiten Reihe beider Flachen
sind gesperrt, um die tangentensymmetrische Bedingung zu erhalten. Sie
kdnnen diese Steuerpunkte nicht ziehen.

o Bei einer Bedingung Kriimmungsabhadngig (Curvature Dependent)
kénnen Sie die Form der Grundflache durch Ziehen der Steuerpunkte der
zweiten Reihe und aller folgenden Reihen andern.

Hinweis: Die Steuerpunkte der ersten drei Reihen der Folgeflache sind
gesperrt, um die Krimmungsstetigkeit zu erhalten. Sie kénnen diese
Steuerpunkte nicht ziehen.

e Ggf. kdnnen Sie die Richtung von Grund- und Folgeflache wechseln. Wéahlen Sie
eine Flache aus, klicken Sie mit der rechten Maustaste, und wahlen Sie
Bedingungen anzeigen (Display Constraints). Wahlen Sie das angezeigte
Bedingungssymbol aus, klicken Sie mit der rechten Maustaste, und wéahlen Sie
HWLinie umkehren (Flip Leader) aus.

Kurven und Flache kopieren

Allgemeine Einfiihrung: Kurven und Flachen kopieren

Sie kédnnen eine Kopie einer Kurve oder Flache erzeugen. Die Kurven werden als freie
3D-Kurven kopiert, wahrend die Flachen als ungetrimmte Spline-Flachen kopiert
werden. Die urspriinglichen Kurven oder Fldchen und die Kopie der Kurven bzw.
Fldchen weisen keine Eltern-/Kind-Beziehung auf. Mit diesem Befehl lassen sich
Kopien von Kurven oder Flachen auch auBerhalb der Restyle-Umgebung erzeugen.
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So erstellen Sie eine Kopie einer Kurve oder Flache

1. Klicken Sie auf [Ef]
2. Wahlen Sie eine Kurve oder eine Flache aus.

Eine Kopie der Kurve oder der Flache wird erzeugt.
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